TheBrain 11 Release History

Version 11.0.107
August 4, 2020
• New Features
  o (#7018) Spanish Localization
• Fixes
  o (#7017) Localization cleanup

Version 11.0.106
August 4, 2020
• New Features
  o (#5475) Paste of thought(s) into notes
  o (#7015) Do not spellcheck URLs and email addresses
• Fixes
  o (#6794) Parenthesis assisted sorting doesn't work when combined with context sensitive thought names
  o (#6943) Notes: Toolbar disappears briefly when notes is focussed via keyboard shortcut
  o (#6952) Notes: Emoji width calculations are inaccurate
  o (#6961) Edit/Insert link dialog should be positioned at the start of the link text
  o (#6986) Japanese Localization Fixes

Version 11.0.105
July 25, 2020
• Fixes
  o (#6910) Notes: Link dialog box location is incorrect if note is scrolled
  o (#6944) Notes: Selecting text that wraps where the last character is an emoji causes crash
  o (#6945) Notes: Non Latin characters are not rendering
  o (#6951) URLs to specific tweets on twitter.com are titled as numbers
  o (#6952) Notes: There is too much space to the right of emoji

Version 11.0.104
July 24, 2020
• New Features
  o (#6911) Japanese Localization
  o (#6941) Username as attachment/thought title when pasting a Twitter URL
• Fixes
  o (#6750) Gravatar image does not update
  o (#6822) macOS: SkiaSharp memory leak in Path.CubicTo > Canvas.DrawPath
  o (#6852) Title parsing should use OpenGraph title tag (for YouTube videos for example)
  o (#6862) Paste Thoughts as Jump Thoughts when pasting from Text Outline under a Type
  o (#6879) Hide Events attached to Private/Forgotten Thoughts when Private/Forgotten Thoughts are hidden
  o (#6894) Update to SkiaSharp 2.80.1
  o (#6910) Notes: Link dialog box location is incorrect if note is scrolled
  o (#6921) Error opening thought link to a deleted thought
  o (#6924) Display does not completely update when system tags are displayed/hidden
  o (#6943) Notes toolbar disappears briefly when notes is focussed via keyboard shortcut

Version 11.0.103
July 14, 2020
• Fixes
  o (#6672) Full sync will fail when using Um Al Qura calendar
  o (#6691) Linking an existing thought with semicolons in its name creates multiple new thoughts
  o (#6753) Move BrainBox tab to new window results in error
  o (#6774) Windows: Uping gets stuck if you decline to restart the first time
  o (#6859) macOS: Incoming notes theme change fails sync
- (#6881) Search box ListPopover NRE
- (#6897) No thought link is created when creating thought from existing text via Insert Link to Thought
- (#6898) Windows: Notes: Trailing space should not be included when auto-selecting text for links
- (#6904) Windows: Opening BrainBox tab causes plex to stop responding to mouse
- (#6905) Windows: Login button on brains list window is too tall
- (#6906) Error displaying license information using Persian calendar

**Version 11.0.102**
July 13, 2020
- New Features
  - (#6857) BrainBox popup toolbar icons with command to open BrainBox in new tab
- Fixes
  - (#5533) BrainBox search should not be cleared when content is updated (after adding something, syncing, etc)
  - (#6896) Windows: Error clicking on a brain from the brains list

**Version 11.0.101**
July 12, 2020
- New Features
  - (#6277) Notes: Automatically select the nearby word when inserting a link if no selection exists
  - (#6891) Notes: Preselect content of edit box in ´Insert Link to Thought´ dialog
- Fixes
  - (#6871) Memory leak on certain dialogs (thought properties, create thought, etc)
  - (#6892) Notes: Insert thought/link input box should appear at current cursor location
  - (#6895) Default to showing all notes toolbar buttons instead of compact toolbar

**Version 11.0.100**
July 10, 2020
- Fixes
  - (#6886) Using the arrow keys to select an existing thought to link to selects every touched

**Version 11.0.99**
July 10, 2020
- New Features
  - (#2461) Link to multiple existing thoughts via typing in the create thought dialog
  - (#6744) Edit menu includes ´Copy as Text´ and ´Copy as HTML´ when notes is focussed
  - (#6792) Notes: Preference to restore cursor and scroll position when returning to a note
- Fixes
  - (#6551) Thought icon click and drag should cancel if mouse not released inside icon area
  - (#6587) Notes: Do not show context menu for read-only brain
  - (#6644) Localization: Polish is incomplete
  - (#6748) If an HTML note contains a base64 encoded image and followed immediately by bold or other formatting, an error occurs
  - (#6772) Actions on the tab context menu should be applied to clicked upon tab, not the currently open tab
  - (#6800) Notes should be excluded in ´internal attachment´ report
  - (#6819) Windows: File access denied when pasting an image as an attachment or icon
  - (#6840) Notes: Right/left arrow keys may skip positions when navigating across a line boundary
  - (#6853) Offline activation of a trial license is valid until “Jan 1, 0001”
  - (#6866) Error when getting folder names for folder export if Thought’s name has only a period
  - (#6868) Clicking on malformed URL link in Notes causes an error

**Version 11.0.98**
June 18, 2020
- Fixes
  - (#6831) Paste command on the Plex shows localization code
  - (#6832) macOS: Notes editor rendering causes memory usage to increase

© TheBrain Technologies LP Page 2 of 24
- Copying an SVG file from notes throws an exception
- Pasting a YouTube link into notes causes an error
- Notes: YouTube preview images should show a "play" button overlay on them

Version 11.0.97
June 15, 2020
- New Features
  - macOS Notes: Enable all Control+Shift modified cursor movement
- Fixes
  - Preferences > Behaviour > Toggle Commands issues
  - macOS: Error if icon in dock is clicked while app is in the process of starting
  - macOS: Rendering of links causes memory leak due to bug in graphics library

Version 11.0.96
June 11, 2020
- Fixes
  - Error on checking for update with Chinese and Polish localizations
  - Mistakes in localization can cause errors at runtime
  - Updated Polish and Russian localizations

Version 11.0.95
June 8, 2020
- New Features
  - Default avatar shows the user's initials
  - Preferences > Behavior > Show Accounts on Brains List
- Fixes
  - macOS: Auto-update from 11.0.80+ not working for some
  - When not logged in, confusion due to not seeing brains for non-local users
    - Show login button on welcome screen if not logged in
    - Show user account buttons on brains list
  - Remove "Open BrainBox" button from brains list
  - Window positions are not restored if they touch the edge of the screen

Version 11.0.94
June 6, 2020
- Fixes
  - macOS: Crashing on clicking links to other brains pasted as attachments
  - Error on changing theme/wallpaper
  - Find and/or replace causes hang if there is only one result and it is at the start of the first line
  - Exporting to folders gives error if any thoughts have notes that are read-only
  - Files added/created are being set as read-only
    - Copied in file attachments are being created as read-only
    - Error on moving a file into TheBrain
    - Error on "Paste Image" when adding attachment to thought
    - Error when adding a file from the templates list
  - Deletion fails if there are read-only internal attachments on a thought
  - Hardware-based customization icon
  - Windows: Installer should not cause/recommend a reboot/restart

Version 11.0.91
June 4, 2020
- Fixes
  - Windows: If Chrome Canary is the default browser, URLs don't open properly
  - Error when expanding the Help menu for certain TeamBrain configurations
  - About dialog should scale down to fit within available screen height
  - Windows: Existing instance is not presented when app is relaunched
Version 11.0.90
June 3, 2020
• Fixes
  o (#6755) Escape key should not exit presentation mode if keyboard navigation is in progress

Version 11.0.89
June 2, 2020
• New Features
  o (#6751) Allow plex interaction while preferences dialog is open
• Fixes
  o (#6592) Copy and paste of notes that include images from one thought to another does not copy the image data
  o (#6670) Report won’t close when the app window is very narrow
  o (#6717) Crash on clicking hidden private thought in selected panel
  o (#6722) Windows: Error on new window/tab to a thought with media on autoplay
  o (#6729) macOS: Some windows (such as Preferences and Reminders) disappear when dragged to a different screen
  o (#6734) Pasting captured Thought icon into Note should create a copy of the icon’s image file
  o (#6745) Read-only file status should not prevent update on sync
  o (#6748) If an HTML note contains a base64 encoded image followed immediately by bold or other formatting, an error occurs

Version 11.0.88
May 28, 2020
• New Features
  o (#6732) Notes: Make paste of color information from HTML an optional preference (results in cleaner text)
  o (#6739) Statistics dialog shows `Local Id` of brain e.g. U01/B01
• Fixes
  o (#6735) Windows: Thought links in notes are not working
  o (#6736) Notes: Subscript and Superscript tags cannot be escaped
  o (#6737) Windows: brain:// protocol does not work from external applications if TheBrain is already open
  o (#6738) Notes: Exception during paste of image leads to unrecoverable error

Version 11.0.87
May 27, 2020
• Fixes
  o (#6643) Localization: Chinese is incomplete
  o (#6727) Windows, dual screens: Fixes for displays at different scales do not function

Version 11.0.86
May 25, 2020
• Fixes
  o (#6642) Localization: German is incomplete
  o (#6645) Localization: Portuguese is incomplete
  o (#6658) On trying to edit Link Type, Plex becomes unresponsive
  o (#6726) Invalid thought icon on a tag causes error

Version 11.0.85
May 19, 2020
• New Features
  o (#6502) Notes: Headerless tables (using empty header cells)
• Fixes
  o (#6611) Tables in Notes should use the available horizontal space better
  o (#6709) OneNote links are no longer recognized
  o (#6710) Notes: Adding images from local sources is not working
  o (#6711) Timeline preferences are not applied at startup
• (#6712) ‘Calendar week starts on Monday’ should be in Preferences > Look & Feel > Timeline

Version 11.0.84
May 18, 2020
• Fixes
  o (#5628) BrainBox browser extensions should work on a Pro License
  o (#6592) Copy and paste of notes that include images from one thought to another does not copy the image data
  o (#6607) Text boxes should not paste Markdown
  o (#6705) Text for BrainBox commands is redundant

Version 11.0.83
May 15, 2020
• Fixes
  o (#4465) Sync error: Access to remote delta unpack directory is denied
  o (#5152) When syncs are resumed multiple syncs may happen at once
  o (#6523) Hide Private Thoughts while active thought is private causes crash
  o (#6603) On a very narrow window, Hidden Brains checkbox overlaps other controls
  o (#6689) Brain Access and Sharing Save button and email invitations are disabled
  o (#6694) NRE when clicking Edit menu option on the Brains List page
  o (#6696) Shift+Tab on an otherwise empty line with blockquote results in an error

Version 11.0.82
May 14, 2020
• Fixes
  o (#4920) Many large thought icons fail to load and cause memory exceptions
  o (#6693) After hovering a thought icon, the larger version loads but does not display immediately

Version 11.0.81
May 13, 2020
• Fixes
  o (#4457) Recurring all day event is displayed a day early on the timeline
  o (#6113) Windows: Context menu causes focus to be lost, which causes system tags to hide then show unexpectedly
  o (#6524) Thoughts copied from Brain to Brain may show an older version of notes from v10
  o (#6601) Deleting a lot of events takes a long time - show progress
  o (#6602) When pasting a typed thought multiple times, it is possible to create links to multiple types
  o (#6650) Error on exporting to folders: trailing space after Thought name
  o (#6657) Placeholder text should not be spellchecked
  o (#6667) macOS: Ability to open Grammarly in embedded browser
  o (#6674) macOS: Error preventing startup when attempting to discover system templates
  o (#6677) macOS: Some attachment templates for different extensions cannot be distinguished
  o (#6678) macOS: Objective C exceptions can’t be caught and cause the application to terminate without notice
  o (#6683) Windows: Exception setting up Explorer ‘Send to’ function prevents startup
  o (#6685) "BrainBox is Empty" does not translate into Russian
  o (#6687) Media back/forward command hint messages are wrong
  o (#6688) Notes: Becomes unresponsive when a very large amount of text on a single line is selected

Version 11.0.80
May 6, 2020
• Fixes
  o (#4973) Windows: Local URL link in embedded browser fails to activate thought
  o (#6660) macOS: Codesigning error upon opening after update

Version 11.0.79
May 3, 2020
• New Features
• Fixes
  o (#6641) German, Russian, Chinese, Polish, and Portuguese localizations
  o (#6568) Notes: Exported HTML should include all notes style settings even when no font is set
  o (#6599) SkiaSharp AccessViolationException
  o (#6636) Notes: A link within a link should not be allowed
  o (#6637) A few pieces of text cannot be localized
  o (#6640) Localization: Refactor code, utilize fallbacks for missing strings
  o (#6647) macOS: Keyboard focus is lost after creating or editing a thought

Version 11.0.77
April 30, 2020
• New Features
  o (#6527) Option to make Paste Without Formatting the default in Notes
  o (#6620) Notes: Save automatically every 30 seconds
  o (#6634) Reorganized notes preferences

• Fixes
  o (#6335) Unable to move Read Only files and folders into TheBrain
  o (#6585) Events deleted count is not always correct
  o (#6593) PDF preview fails when renaming/deleting/moving file in/out of Brain and PDF is open in app
  o (#6597) Error on exporting to folders: "Could not find a part of the path"
  o (#6600) Error setting layout generation
  o (#6623) Notes: Multiple images in a single line can cause crash
  o (#6624) Notes: Markdown links that include titles are not recognized
  o (#6626) Export to folders uses one folder for multiple thoughts in the same hierarchy level with the same name

Version 11.0.76
April 25, 2020
• New Features
  o (#6532) New preference for default visibility of thumbnails in PDF preview
  o (#6572) Preferences > Keyboard shortcuts tab - send focus immediately to the search field
  o (#6604) Paste Without Formatting to be added to the Edit menu when notes has focus

• Fixes
  o (#5809) Windows, dual screens: Drag to create a new child thought - no new thought name field appears
  o (#6427) Creating a child from a type/tag should indicate in the dialog that new thought will be typed/tagged
  o (#6453) Pasting thoughts under a type should link pasted thoughts as jumps instead of children
  o (#6563) 'Open Attachment' on a link with multiple attachments causes error
  o (#6575) Brain settings should not be added to undo list on startup/open brain
  o (#6579) Notes: HTML files with invalid styles cause an error
  o (#6581) macOS: Unable to select date from Delete Events calendar drop-down
  o (#6583) Thought with link to an external read-only file should not fail to delete
  o (#6605) Notes: Large images encoded within text as base64 data cause poor performance
  o (#6610) Notes: Improve performance of image tag detection

Version 11.0.75
April 20, 2020
• New Features
  o (#6588) Utility to enable Windows search of older notes by adding BOM to start of the files

• Fixes
  o (#6408) Windows: Non-ASCII characters are not indexed by Windows search
  o (#6589) Dialogs are not always centered correctly
  o (#6590) Commands under File > Utilities should disable (not disappear) when a brain is not open
  o (#6591) Count of hidden brains should be part of checkbox

Version 11.0.74
April 17, 2020

• New Features
  o (#2986) Hide brain command on brain context menu
  o (#4620) Bulk delete of events by date range from the timeline
  o (#6382) Open Brain to Home Thought command on brain context menu

• Fixes
  o (#4801) Allow all users to see who has what level of access to a shared brain
  o (#6275) Unable to move Read Only files into TheBrain
  o (#6311) Unable to scroll through added users in the Brain access and Sharing window
  o (#6322) PDF Preview/Media player is not re-initialized after hovering over another thought
  o (#6335) Unable to move folders with Read Only files into TB
  o (#6363) No warning or info when deleting a thought with an open file attachment
  o (#6390) Keyboard shortcut for Delete Attachment causes an error while an event is displayed in content area
  o (#6423) Dialogs allow multiple instances to be opened
  o (#6485) When deleting a single recurring event, closing the recurring event warning dialog proceeds with deletion
  o (#6491) Windows: Brain Access and Sharing dialog’s user access level selection menu does not show check mark in dark mode
  o (#6513) Windows: Right click on Add Attachment > Create File entry should not do anything
  o (#6522) Keyboard shortcut for Delete Selection does not work
  o (#6538) Deleting a thought with an open file attachment should fail gracefully
  o (#6541) Notes: Paste of link containing underscore does not retrieve title correctly
  o (#6543) ‘Visible when Parent of Active Thought’ should be disabled for readers
  o (#6555) When report time filter is changed using menu the plex may stop responding
  o (#6556) Windows: Some context menu check marks do not show in dark mode
  o (#6558) Error when opening brain access dialog
  o (#6559) Windows: Notes style weight sub menu is not styled correctly in dark mode
  o (#6560) Should not show "failed to shutdown" unless failure happens soon after startup
  o (#6561) Notes: URLs including parenthesis are not recognized correctly
  o (#6562) Application state should be saved more often
  o (#6566) Moving attachment out of Brain while the attachment is open should fail safely
  o (#6567) Notes: When exporting to HTML, headings are not recognized if there is not an empty line above them
  o (#6576) Redo of move folder into Brain causes error

Version 11.0.73
April 13, 2020

• New Features
  o (#6544) More powerful recent changes popup
    ▪ (#6552) Filter recent changes by user
    ▪ (#6553) Configurable number of days for recent changes
    ▪ (#6554) Improve speed of recent changes display

• Fixes
  o (#3165) Outline view context sensitive name removal does not work properly
  o (#4849) Recent changes list does not show custom user avatar icon
  o (#5936) Context sensitive names not hiding/showing Parent name consistently
  o (#6013) Temporary white space appears over image pasted into notes
  o (#6065) Windows: Notes scrollbar toggles on and off repeatedly when image is present and content just fits
  o (#6108) Unchecking ‘Sync Automatically’ from sync status popup does not work
  o (#6483) Notes: NRE in LayoutLines
  o (#6515) Image resizing handles are not cleared when navigating
  o (#6518) macOS: Selected Thoughts area, Past Thoughts List area, and Pins area should clip thoughts in Outline and Mind Map layouts
  o (#6520) Notes: Image resize handles are replicated when note width is changed
  o (#6521) macOS: Double-click to open the TPD makes the cursor disappear
  o (#6525) macOS: Notes: Ctrl+click should show context menu
• (#6526) macOS: Import text explanation is clipped on initial display
• (#6534) Notes: Link to missing file causes error
• (#6537) Error on opening Brain Theme window
• (#6539) Missing brain icon causes thumbnail to render as all black
• (#6542) Some html notes from TheBrain 10 are freezing up TheBrain 11
• (#6545) Can't check sync status nor change auto-sync settings when a sync is in progress
• (#6546) Notes: Some notes are very slow to load
• (#6547) Notes: Images with base64 encoded ‘data’ source do not load
• (#6550) macOS: Recent changes hint window does not show on mouseover after scroll by dragging

Version 11.0.72 (Windows)
April 3, 2020
• Fixes
  • (#6514) Windows: Error opening brain access and login windows

Version 11.0.71
April 3, 2020
• Fixes
  • (#6510) Right click on attachment tab causes error

Version 11.0.70
April 2, 2020
• Fixes
  • (#6387) Windows: The application does not stay running in the background
  • (#6490) Error when attempting to display Note content
  • (#6507) Notes: Multi-line tables are not exported to HTML properly
  • (#6508) Popup menus that open from toolbar buttons and icons are not aligned with the button
  • (#6509) Increased background CPU usage due to unnecessary rendering of notes

Version 11.0.69
April 2, 2020
• New Features
  • (#6493) Shift+Enter for multi-line bullets, headings, etc
  • (#6494) Multi-line table cells (‘Enter’ inside of a table cell creates a new line within the cell.)
  • (#6495) Support for <br> tags forcing a line break within a single physical line
• Fixes
  • (#5291) TPD text/color switcher has unexpected results on thoughts that are typed
  • (#5304) Windows, dual screens: Displays at different scales can cause dialogs to appear off-screen
  • (#5807) Windows, dual screens: Context menus are not scaled correctly
  • (#5808) Windows, dual screens: Existing thought list not showing
  • (#5809) Windows, dual screens: Drag to create a new child thought - no new thought name field appears
  • (#6019) Using the keyboard shortcut to delete a child thought while in outline view causes keyboard navigation to stop working
  • (#6474) Notes: Add toolbar button linking to Notes Markdown reference
  • (#6488) macOS: Notes: Cursor does not show when tab is moved between windows
  • (#6501) Notes: Copy/paste of multiple lines of text to/from a table should work as expected

Version 11.0.68
March 26, 2020
• New Features
  • (#3979) Keyboard shortcut for zoom in/out should work for notes when notes is focused
  • (#6477) Pinch to zoom in/out of notes
• Fixes
  • (#6460) Notes: When converting from HTML, lines of dashes or underscores should be interpreted as horizontal rules
  • (#6478) Notes: Zoom in/out commands should be the same as the plex zoom in/out commands
  • (#6487) Notes: Failure to advance error when text is size is very large
Version 11.0.67
March 19, 2020
• Fixes
  o (#6465) Error while loading some notes (NoteType NRE)
  o (#6466) Notes: ArgumentOutOfRangeException while updating toolbar status

Version 11.0.66
March 19, 2020
• Fixes
  o (#6268) Error caused by KezaSheet.LayoutLines
  o (#6311) Unable to scroll through added users in the Brain access and Sharing window
  o (#6383) Long Chinese thought names overflow the TPD text box and aren't completely visible
  o (#6420) Notes: Pasting a YouTube link while manually writing Markdown link code causes error
  o (#6430) Notes: When converted from V10, sometimes @@ symbols appear for checkboxes
  o (#6435) Notes: Indented checkboxes from HTML notes don't get converted properly
  o (#6437) Text boxes (such as Search) are very short when a single character is entered
  o (#6440) Notes: If a Notes.md file is manually added to a thought folder, it is not interpreted correctly
  o (#6442) Notes: When converting HTML, linebreaks that should not be removed sometimes are
  o (#6443) Notes: Manually created checkboxes in HTML notes are not converted
  o (#6455) Notes: Code sections do not display correctly when exported to HTML
  o (#6456) Notes: Images from V10 notes notes are not visible when exported to HTML
  o (#6457) Notes: When converting from HTML, indented titles should have `>` characters before the `#`, not after
  o (#6460) Notes: When converting from HTML, lines of dashes or underscores should be interpreted as horizontal rules
  o (#6461) Notes: When converting from HTML, dashes and underscores in link and image addresses should not be escaped
  o (#6462) Notes: Deleting the entire text of a note can cause an error
  o (#6463) Notes: When images are used as links, the next line's height is incorrect, images fail to wrap to the next line

Version 11.0.64
March 12, 2020
• Fixes
  o (#6425) Underlined and strikethrough text from v10 is not styled correctly in v11
  o (#6428) Opening the thought properties dialog sometimes causes error
  o (#6433) Inaccurate detection of failure to advance position when breaking line leading to error

Version 11.0.63
March 11, 2020
• New Features
  o (#6421) Notes: Export PDF - option to keep colors or use black text on a white page
• Fixes
  o (#6413) Conversion from html to markdown should escape dashes and underscores
  o (#6415) Select stock icon dialog error
  o (#6416) macOS: Select folder dialog errors
  o (#6419) Notes: Hang/Error when images are used as links or text follows image immediately
  o (#6422) Notes: Line spacing can't be set when decimal separator for locale is a comma
  o (#6424) Windows: Error viewing password-protected PDF attachment

Version 11.0.62
March 6, 2020
• New Features
  o (#6338) Thought icon should retain domain favicon for multiple URL attachments from same domain
• Fixes
  o (#6311) Unable to scroll through added users in the Brain access and Sharing window
  o (#6405) Windows: Crash during app initialization due to file permissions
• Error encountered during search
• Parsing certain markdown leaves app unresponsive

Version 11.0.61
March 5, 2020
• Fixes
  o Copy as text outline with notes may not always contain the current changes to the active note
  o Windows: Corner icon menu does not show in the correct location
  o Notes: Font size in font selection box is very large when locale uses comma for decimal separator
  o Notes: Chinese/Japanese/Korean should allow line breaks between most characters
  o Only one cursor should show in Notes OR Search box, not both
  o macOS: Brain Theme changes (colors etc) are not displayed immediately
  o Notes: Line breaks should not happen between Markdown tags and text
  o Notes: Chinese/Japanese/Korean extend beyond the margin
  o Notes: Chinese/Japanese/Korean should allow line break after (but not before) ‘。’ and ‘，’
  o Notes: When there are line breaks between CJK characters, the background showing what is selected does not extend to the end of the line

Version 11.0.60
February 27, 2020
• Fixes
  o macOS Mojave: Application will not start
  o Do not create unnecessary modification logs

Version 11.0.59
February 26, 2020
• Fixes
  o File attachments/notes not updated during sync

Version 11.0.58
February 25, 2020
• Fixes
  o Commands from the context menu of TPD applied to wrong thought
  o Missing word in description of ‘Open Folder’ command
  o License agreement references beta version

Version 11.0.57 - Official Release
February 24, 2020
• This release does not expire

Version 11.0.56 - Release Candidate
February 22, 2020
• Fixes
  o Notes: Support for backslash escape sequences
  o Pasting Local Thought URL into notes should link to the thought
  o Copy Thought and paste into notes of different brain should paste local thought link
  o Popup lists should show more items by default before showing a scrollbar
  o Converting some notes from HTML format may cause hang
  o macOS: No visual feedback on drag and drop while app is in the background
  o Issues when syncing as Reader
    o Unauthorized file deletion detected when syncing as Reader
    o Unauthorized attachment update detected when syncing as Reader
    o Changes are not reflected immediately when syncing as Reader
    o Removed file fails to delete when syncing as Reader
Version 11.0.55 (macOS)  
February 19, 2020  
• Fixes  
  o (#6328) macOS: Application will not start after reboot

Version 11.0.52 (Windows) / 11.0.53 (macOS)  
February 17, 2020  
• New Features  
  o (#5734) Notes: List of fonts can be browsed using `Next` and `Prev` buttons  
• Fixes  
  o (#4613) macOS: High CPU usage when application is inactive (not syncing or animating)  
  o (#5575) Notes toolbar adjustments  
  o (#6266) macOS: In presentation mode, icon names are persistent  
  o (#6296) Notes: Pasting a thought should create a link to the thought  
  o (#6302) Notes: Font size in font selection box is very large  
  o (#6305) Text at the bottom of the Font window that shows the Font count is not visible in Dark Mode  
  o (#6318) Enable display of remote brains upon account creation  
  o (#6319) macOS: Notarization is failing

Version 11.0.51  
February 10, 2020  
• Fixes  
  o (#4098) Windows: Application icon pinned to taskbar breaks after application update  
  o (#6260) Windows: Notes: Scroll using page down does not work correctly after pasting a large amount of text  
  o (#6271) Notes: Pasting a link to an image that does not exist causes poor performance  
  o (#6286) When adding an attachment, only verify file access before move/copy operation  
  o (#6294) macOS: Notes: Page up/down should move cursor if option/alt key is pressed  
  o (#6306) macOS: Poor performance - UI sometimes responds slowly or lags

Version 11.0.50  
February 5, 2020  
• New Features  
  o (#6272) Custom brain icons  
• Fixes  
  o (#4206) Windows: Application icon pinned to taskbar breaks after application update  
  o (#5794) Quick start brain does not show videos properly  
  o (#5927) macOS: OneNote links result in unexpected error  
  o (#6134) Windows: The ’Menu’ key should open the context menu for the notes  
  o (#6202) Notes: Pasted URL is broken if web page has square brackets in title  
  o (#6203) Notes: Some YouTube URLs pasted into notes are missing thumbnails  
  o (#6236) Notes Editor: Open in Browser should show selected fonts and image assets as expected  
  o (#6261) Crash when using keyboard shortcut for Switch Name and Label  
  o (#6270) Notes: Broken image links should show a placeholder image  
  o (#6279) Windows: Toolbar icons in dark mode are not high resolution  
  o (#6281) Media player visual tweaks  
  o (#6282) Windows: When display is set to 150% and dark mode is on, toolbar icons appear as squares  
  o (#6283) Windows: Color chooser swatches have white squares in the center  
  o (#6292) ‘iframe’ content in HTML notes should convert to links in markdown

Version 11.0.48  
January 24, 2020  
• New Features  
  o (#6241) Auto play preference for audio/video files  
• Fixes  
  o (#5756) Notes: Span end tag `\)` is drawn using the wrong colors  
  o (#5901) TheBrain does not launch on macOS Catalina for some users
• (#6058) Error when pasting large content into notes
• (#6084) Startup is slow on first run after update to newer version
• (#6107) CF_HTML header text should not be included when pasting after "Copy as HTML"
• (#6124) Links sometimes disappear from the display after being modified
• (#6141) Change wording of the TB prompt when opening an unsupported future version Brain
• (#6142) Pasted image attachments are always saved as PNGs, making the files very large sometimes
• (#6178) OutOfMemoryException when extracting a very large downloaded Brain
• (#6184) Notes: Cursor moves to bottom of document when navigating in a table
• (#6187) macOS: PDF shows raw formatting in embedded viewer when PDF title has special characters
• (#6195) Unsafe character in URL attachment name only after link is renamed
• (#6207) Attachment with no extension showing as embedded media
• (#6212) Windows: Sometimes copying text causes error related to clipboard
• (#6213) Check for newline characters in names during import
• (#6216) Helvetica is listed multiple times in Brain Theme Plex Font
• (#6221) Localization issues
• (#6232) Windows: Various errors related to clipboard access
• (#6239) Custom thought context menu commands list does not scroll
• (#6242) Enable hardware-based customization
• (#6246) Copy web attachment should also copy URL as text to clipboard
• (#6247) Brain access and sharing dialog layout issue
• (#6248) Undo of rename URL attachment results in error
• (#6249) Folder attachments cannot be copied from TheBrain and pasted to the desktop
• (#6256) When content area is hidden, do not auto-play videos
• (#6258) Windows: Improve handling of multiple application instances
• (#6262) Error converting HTML to MD

Version 11.0.47
January 13, 2020
• New Features
  • (#6163) Clear inheritable properties of a thought command (reverts to setting from type)
  • (#6172) Support for .mov video files
• Fixes
  • (#4206) Windows: Application icon pinned to taskbar breaks after application update
  • (#6017) Undo of wallpaper change should add/delete the wallpaper image accordingly
  • (#6076) Error: Sync already initialized
  • (#6130) Resend activation link missing on desktop
  • (#6136) Media attachments can't be deleted/moved
  • (#6147) Plex and Notes swap icon does not work until Notes/Plex is hidden and shown again
  • (#6160) Dropping a URL in the content tab area does not attach it to the Thought
  • (#6173) Media player commands activated via keyboard shortcut cause error if media player is not active
  • (#6185) Default Themes - Note style doesn't update immediately
  • (#6202) Pasting URL in notes is broken if web page has square brackets in title
  • (#6208) Attempting to undo after attaching an internal PDF file causes error
  • (#6211) When creating a Brain Backup, TB should inform users of invalid file names
  • (#6217) Make "time too different" errors less prominent

Version 11.0.46
December 13, 2019
• New Features
  • (#2821) Prioritize and separate user file attachment templates from templates
• Fixes
  • (#6122) Unable to move a PDF file attachment out of TheBrain using "Move file out of Brain" command if the PDF is still loaded in the previewer
  • (#6171) Windows: Performance of entire application is increasingly degraded as run time increases
Version 11.0.45
December 13, 2019

• New Features
  o (#2651) Windows: The `Menu` key should open the context menu for the focused thought
  o (#3935) Option to not display Brain name in Tabs
  o (#5993) Embedded player for video and audio file attachments
  o (#6086) Paste of wallpaper via a copied image file
  o (#6111) Copy from BrainBox (rather than Move)
  o (#6135) Windows: Improved performance when `Compact Title Bar` is enabled

• Fixes
  o (#4902) No preview for JPG attachments
  o (#5249) Some image files do not load when their extension is .jpg but do load if renamed to .jpeg
  o (#5481) JPG image attachments preview displays incorrectly
  o (#5912) In readonly mode, should not be able to edit notes/attachments
  o (#6149) Windows: Portrait images with extension .jpeg do not show in correct orientation
  o (#6150) macOS: Selecting a theme in the Brain Theme window results in an error
  o (#6151) Windows: Link label text appears in the wrong position in v11
  o (#6161) Paste icon command exception checking if clipboard text is file path

Version 11.0.44
December 10, 2019

• New Features
  o (#3058) Empty the internal trash to the OS trash
  o (#4000) Add "Move" option when pasting an existing URL or external file
  o (#4057) Separate preferences for Notes and Events indicators

• Fixes
  o (#3638) Disabled `Paste` command should show in context menu
  o (#5666) TB11: Drag emoji through single-line text box in Thought properties name field drops emoji into name and replaces entire string
  o (#5912) In readonly mode, should not be able to edit notes/attachments
  o (#6093) Clicking on a search result for an event with no associated thought should not activate a thought
  o (#6121) Selection context menu: `Set Type` should be before `Set Tags`
  o (#6125) Windows: After using the report's time popup menu, the plex stops responding
  o (#6129) UI of prompt for already existing external file/URL attachment should match UI for already existing internal attachment
  o (#6144) Initial events indicator setting should be set based on prior notes indicator setting
  o (#6145) macOS: YouTube video should stop playback (esp. audio) when video attachment no longer showing

Version 11.0.42
December 3, 2019

• New Features
  o (#4238) URL attachments context menu command: `Open Using Wayback Machine`
  o (#5939) Preset date ranges for reports
  o (#6102) Make thought and link types uncheckable, consistent with tags

• Fixes
  o (#3963) Notes: Images aren't inserted at dropped location when dragging in as a file from Finder/Explorer
  o (#4422) Windows: OutOfMemoryException related to animated toolbar buttons
  o (#5556) Invalid attachment name handling needs improvement
  o (#6094) macOS: Changing colors while a non custom theme is selected causes TheBrain crash
  o (#6112) Windows: OutOfMemoryException in KezaToolbar
  o (#6119) Animations for buttons, notifications, etc should not use bespoke timers
  o (#6120) macOS: Utilize fewer CPU resources when idle

Version 11.0.41
November 27, 2019
• New Features
  o (#6046) Notes: Copy images to clipboard as images

• Fixes
  o (#5281) Notes: Links to thoughts in a copied/duplicated Thought do not work
  o (#6101) Windows: Logo is the wrong scale on the login window

Version 11.0.40
November 26, 2019
• Fixes
  o (#6083) Failure to find Brain key during RestoreWindowState

Version 11.0.39
November 25, 2019
• New Features
  o (#6088) Option to suppress newer data version warning

• Fixes
  o (#1939) Right-click context menu in Selected Thoughts should show correct context menu
  o (#4544) Search should not find links whose thoughts are forgotten/private if those thoughts are filtered from display
  o (#5362) Windows: "Maximized" window doesn't fill screen when scale is >= 200% and compact title bar is on
  o (#5686) Windows: Difficult to resize window when compact title bar is enabled
  o (#5876) Windows: If closed while maximized, next launch opens in a maximized state but not covering the full screen
  o (#6025) Shift+Click on search result causes multiple focus rectangles to be shown
  o (#6040) Changing colors while a non custom theme is selected causes error
  o (#6084) Startup is slow on first run after update to newer version
  o (#6090) Update sample text for notes theme to describe how to make changes
  o (#6096) Brain commands (Rename, Statistics, Access and Sharing, etc) may not apply to the currently open brain

Version 11.0.38
November 20, 2019
• New Features
  o (#2542) Preferences > Show wander delay setting in seconds
  o (#6061) New notes editor command to bind to shortcut for Center Cursor in Visible Area
  o (#6062) Notes: Allow theme editor to toggle Italics for paragraph and heading styles

• Fixes
  o (#6048) Windows: Startup fails - event logs mention kernelbase.dll
  o (#6052) Content does not default to Notes if Attachments as List is active
  o (#6066) Logging is needed to better track startup time
  o (#6067) Export dialog causes error when current note style is "Foundation" or other new style name
  o (#6068) Remove old notes code
  o (#6072) Increase logging of file access errors during export-sync
  o (#6075) Export > Folders should export notes as Markdown
  o (#6078) Text in export, import, and tips should be readonly
  o (#6081) macOS: Help > Show Tips does not work

Version 11.0.37
November 15, 2019
• Fixes
  o (#2594) When context sensitive names are disabled via preferences, existing displayed thoughts are not updated until the active thought is changed.
  o (#6024) If tips window is already open, show tips command should not do anything
  o (#6057) Attempting to open a remote Brain results in an error
  o (#6059) Required authentication produces an error

Version 11.0.36
November 14, 2019

• New Feature
  o (#5969) Auto select first attachment when opening list of attachments

• Fixes
  o (#2645) Setting background color should disable wallpaper
  o (#5743) Check min version required by brain database when opening
  o (#6047) Dismissing the Link Properties dialog leaves empty box and plex stops responding

Version 11.0.35
November 13, 2019

• New Features
  o (#2077) Notes: Ability to resize images for videos
  o (#4419) Rename URL to non-HTML content using filename
  o (#6041) Notes: ‘Select All’ command in context menu

• Fixes
  o (#3174) macOS El Capitan: PDF preview does not work
  o (#3436) In the Notes Editor, Shift+Return can remove a space
  o (#3446) AttachmentWebView: right-click Context should work correctly
  o (#3491) macOS: Notes: Backspace of bullet makes cursor jump
  o (#3669) Notes Editor - Cursor jumps away from blank line created with Shift+Enter
  o (#4516) Japanese text converts to underscore lines instead of kanji
  o (#5484) Switching to italics mode while typing on the same line in notes switches back to normal on next word
  o (#5715) Deleting an attached PDF does not work if TheBrain is/was previewing that attachment
  o (#5772) Notes: Text is missing from printed output/PDF export if last paragraph straddles the page boundary
  o (#5837) Windows: Plex not responding after deleting a link via link properties dialog
  o (#5892) Tips windows not sized properly for several seconds
  o (#6021) Default state for metadata overlay on images should be hidden
  o (#6023) Notes: Copy as HTML/Copy as Text are disabled for MD files that are not notes
  o (#6026) Keyboard shortcuts for indent and outdent are not displayed if any custom shortcuts have been set
  o (#6027) All command names should be capitalized using title case
  o (#6028) Unable to change Notes theme to black text white page when in dark mode
  o (#6029) Paste without formatting always pastes into the notes editor even if focus is elsewhere
  o (#6034) Rich clipboard content should not be pasted into simple textboxes
  o (#6035) Text editor should ignore MD table tags
  o (#6036) Brain opening is slow to complete
  o (#6042) Notes theme sync causes error
  o (#6043) Windows: List of colors in brain theme dialog moves as you interact with it

Version 11.0.34
November 11, 2019

• Fixes
  o (#6009) Undoing initial Brain Theme should revert to default Theme
  o (#6018) Clicking on avatar causes an error

Version 11.0.33
November 7, 2019

• New Features
  o (#2759) Image preview > Context menu > Copy as Image
  o (#5870) Notes: ‘Edit Link’ context menu command

• Fixes
  o (#1811) Starting Thought in a new brain can be removed with Edit > Undo
  o (#3873) Notes: Drag and drop image directly from Chrome should embed/insert as expected
  o (#5915) Toggling siblings on immediately after navigation does not work
  o (#5949) Notes: Chinese text sometimes does not render correctly
  o (#5955) Cannot access a disposed object (DialogBackend)
macOS: Error encountered when quitting the app

Windows: Keyboard shortcuts should not be present for macOS commands (Application > Hide Others and > Hide TheBrain)

Forget/Delete context menu command from a report is disabled when keyboard focus is notes

Windows: Alt+F4 closes all windows instead of just the current window

Notes: Images pasted from files on Windows use backslashes in path, preventing display on non-Windows clients

macOS: Drag and drop of emoji into an edit box results in extra emoji

Version 11.0.32
November 6, 2019

• New Features
  o (#5994) Additional color settings for notes (background and edge colors)

• Fixes
  o (#5837) Plex not responding after deleting an imported Link Type
  o (#5963) Search tokens may be rebuilt when not necessary ("First-Use Preparation" shows when opening)
  o (#5984) Windows: Text is not always copied exactly
  o (#5991) macOS: Should not select a space when using Option+Right Arrow
  o (#5992) Auto sync status incorrectly shows as disabled
  o (#5996) macOS: Application not responding after unplugging and plugging external displays
  o (#6000) Notes toolbar layout firing when notes are not visible, causing many log entries
  o (#6014) macOS: Drag and drop of emoji into an edit box results in extra emoji

Version 11.0.31
October 25, 2019

• New Features
  o (#2543) "Steal" keyboard shortcut if typed combination is currently in use
  o (#2573) Toggle siblings keybinding
  o (#5972) Ability to select and copy text from the PDF previewer

• Fixes
  o (#3357) Importing MindManager files fails
  o (#3818) Hidden prefix should be removed from type changes message in history of thought
  o (#5975) Crash when copying text in notes

Version 11.0.30
October 24, 2019

• New Features
  o (#2891) Add "Last Sync Date" to Statistics in Brain list
  o (#3497) Arrange thoughts by date (oldest first)
  o (#5916) Support for delete by word (Windows: Ctrl+Backspace/Delete, macOS: Cmd/Alt+Backspace/Delete)
  o (#5929) Sort by context sensitive name
  o (#5931) Activate a thought quickly by typing its name and pressing enter without waiting for results to appear

• Fixes
  o (#2498) Notes: Superscript and subscript can be on at the same time
  o (#3817) Hidden prefix should be removed from type name on type button in TPD
  o (#5466) Home Thought can be deleted from the report
  o (#5661) Windows: Unable to delete Thoughts with an internal folder if Brains data folder is not on C drive
  o (#5897) Notes: In dark mode, a "ghost" image of the text prior to the most recent change is visible
  o (#5911) Images inside of MD files need updated filenames to match GUID on assign brain GUID
  o (#5926) Extra notes interrupt plex keyboard navigation
- Text in font selection dialog is unreadable in dark mode
- Do not open .md and .txt files when they are created from templates
- macOS: No selected theme causes error on export
- It should not be possible to change the keyboard shortcuts for some commands
- Toolbar button tooltips/hints do not update keyboard shortcuts immediately
- Windows: Keyboard focus is lost when search results display
- Move right by one word (Ctrl/Alt+Right) should move to the start of the next word
- Local-only user only has read-only access
- Stack overflow when saving a note and "Update on hover" is enabled
- macOS: High CPU usage and suboptimal UI responsiveness

Version 11.0.29
October 16, 2019
- New Features
  - When internal browser address is selected, automatically select it
  - Better preservation of formatting on copy/paste from Google docs to TheBrain
  - Accept URLs using protocols containing numbers
  - Windows: Updated internal browser to Chromium 75
  - Notes: Unable to paste a picture copied as a thought attachment
  - Notes: Paste without formatting
  - Windows: Enable use of ‘Alt’ as a standalone modifier for keyboard shortcuts
  - Preferences tab navigation via Ctrl+Tab and Ctrl+Shift+Tab
  - Notes: Copy as text
  - Notes: Copy as HTML
- Fixes
  - Mac: Text/space is automatically highlighted on right-click in Notes.
  - macOS: Can't paste Chinese with Cmd+V shortcut
  - Wingdings do not paste into thought names or notes
  - Line breaks inserted after hyphens when copying to email
  - Blank spaces when pasting text outline with Danish letters in notes
  - Resizing TheBrain window when YouTube video is playing - cause freeze / crash
  - Emoji options in the Windows keyboard shortcut list
  - Windows: Copy of image file and paste into notes fails
  - Possible errors when opening attachments
  - Windows: right-clicking on emoji in notes editor causes crash
  - Pasted text from email/Emvernote in notes removes spaces
  - macOS: Cut and paste inserts extra line
  - Undo is not available after pasting into notes
  - Separators in date/time format for notes are changed
  - Notes: Can't paste after shift+enter
  - Amazon web pages no longer load in embedded browser
  - Renamed URL reverts back to original name once a Thought is created from it
  - Notes Editor: Insert Link to Thought can create a double link
  - Edit menu undo and redo commands do not apply to the notes editor
  - Preferences > Keyboard issues
  - Windows: Default back/forward shortcuts should be Alt+Left/Right
  - Windows: Default open properties shortcut should be Alt+Enter
  - Notes toolbar buttons appear in a vertical column
  - Unindenting a numbered list moves cursor to next line when at end of line
  - Indent of numbered list item over 9 puts cursor in wrong place
  - Remove the keyboard shortcut for Expanded View

Version 11.0.28
October 11, 2019
- Fixes
  - macOS: Double click title bar does not follow action set in System Preferences > Dock
  - Attaching a URL to an existing Thought breaks the url
• (#5913) macOS: Clicking tag button from create thought dialog sometimes causes error

Version 11.0.27
October 11, 2019

• Fixes
  o (#5907) Assign Brain new GUID does not update GUIDs in brain links in markdown notes
  o (#5909) Windows: Missing dependencies on some computers
  o (#5910) Additional Markdown files are treated as plain text

Version 11.0.26
October 10, 2019

• New Features
  o (#5822) Integrated ability to edit text files

• Fixes
  o (#3873) Notes Editor: drag and drop image directly from Chrome should embed/insert as expected
  o (#4588) Bulleted lists cannot retain Bold formatting
  o (#5057) Unordered list does not retain formatting when using arrow keys
  o (#5411) macOS: Remove temporary view fix
  o (#5580) Remove formatting button does not affect Super/Subscript
  o (#5801) TheBrain 11 does not start on some Windows environments
  o (#5873) Windows: Space added in search box when selecting a result using the `Enter` key
  o (#5889) Spellcheck should be disabled for readonly controls (tips, export, etc.)
  o (#5890) macOS: HintWindows do not display (recent changes details and icon names)
  o (#5893) CJK character not displaying correctly in TheBrain’s txt file previewer
  o (#5894) Line breaks should be allowed after semi-colons
  o (#5896) Multiple lines with checkboxes can’t be toggled if some but not all boxes are checked
  o (#5897) macOS: Notes: In dark mode, a “ghost” image of the text prior to the most recent change is visible
  o (#5898) Windows: The last search query should be pre-selected when it auto populates
  o (#5899) Clear formatting should remove paragraph type (bullets, checkboxes, headings, etc)
  o (#5905) First open of a brain after startup causes an error
  o (#5906) Tilde should not be interpreted as subscript when at the start of a word

Version 11.0.23
October 7, 2019

• New Features
  o (#1165) Tab key navigation for all dialogs
  o (#2695) Block quotes using standard Markdown `>` prefix
  o (#3716) Search option in stock icon library
  o (#3965) Notes: Enable copy/paste, drag/drop multiple images at a time
  o (#5877) Show name of stock icon when hovering over it in the icon selection dialog
  o (#5883) New menu command: Options > Check Spelling as You Type

• Fixes
  o (#2081) Right click in Notes should activate editor
  o (#2474) Last character of long, new thought name cannot be seen
  o (#2810) macOS: Emoji & Symbols popup shortcut does not work in some places.
  o (#4459) Windows: Relative position of IME is not correct and changes with scale
  o (#5136) If preference on drag is set to move, you cannot drag attachments from one thought to another
  o (#5679) Arrange Thoughts by Date Activated not working
  o (#5746) In dark mode notes and edit boxes should invert
  o (#5762) Windows: Unable to rename/delete/cut/move internal and external PDFs while previewing
  o (#5834) When a Brain is opened, set keyboard focus to search
  o (#5842) Text at the bottom of the Brain Access and Sharing window does not wrap
  o (#5878) Windows: Exception when renaming an attachment that is in use
  o (#5880) Windows: Sometimes can't delete thought with PDF attached
  o (#5881) When application is opened, set keyboard focus to search box
  o (#5882) Spellcheck cannot be permanently disabled
Version 11.0.22
October 2, 2019
• Fixes
  o (#5863) Continuous errors when "update displayed content on hover" is enabled

Version 11.0.21
October 2, 2019
• New Features
  o (#2243) Integrated editing and preview of markdown attachments (not just notes)
  o (#4601) Multiple notes per thought/link
  o (#4725) Preview of .json files
  o (#5815) Notes: Show character count when hovering over word count
  o (#5844) Redesigned UI for adding attachments
• Fixes
  o (#4364) Text pasted into a code area should retain all spacing and text
  o (#5461) Thought's multiple attachment window does not scroll when using down arrow to traverse through attachments
  o (#5545) Text pasted in a Thought's Notes not responding to user edits
  o (#5735) Cannot right click on a hidden private Thought from a report
  o (#5766) Crash when creating a new thought from the timeline in a Read Only Brain
  o (#5768) Notes compact toolbar preference does not update immediately
  o (#5777) Icon categories are not in alphabetical order
  o (#5795) Right click on attachment tab when attachment as lists acts as if it is a right click on background area
  o (#5797) Create event dialog on the Timeline is off-screen
  o (#5802) Windows: Startup is slow (splash screen stays on for a long time)
  o (#5812) Notes: Word count is inaccurate
  o (#5814) Error when hovering over BrainBox icon or clicking avatar if window has no tabs
  o (#5816) Error encountered when window restoration state is corrupt
  o (#5820) Double clicking on Note/Attachment Tab does not maximize
  o (#5832) Windows: Chinese IME does not work in notes
  o (#5841) macOS: When naming a Thought, Command-J will add :-: and --: to the thought name
  o (#5847) Notes: Print/Export to PDF fails when a table is present
  o (#5849) Toggling of word count does not work until resize or reload
  o (#5850) Keyboard shortcuts for notes should not do anything if note is not focused
  o (#5852) Sometimes, the keyboard focus is set in notes without the hidden tags being displayed
  o (#5854) Windows: Text input issues
    • (#5800) Windows: Korean IME does not work in notes
    • (#5833) Windows: Emoji keyboard does not add emoji
    • (#5855) Windows: “AltGr” modified key presses are ignored
    • (#5856) Windows: Dictation does not work
  o (#5859) An error is raised when attempting to log in with invalid credentials
  o (#5860) Log contains inaccurate messages about attachment search
  o (#5861) Search for internal files and notes does not work if Brains folder capitalization has been changed
  o (#5862) On high DPI screen, IME appears in the wrong location

Version 11.0.19
September 24, 2019
• Fixes
  o (#5779) Brain icons missing from icon library
  o (#5786) macOS: Text entry field for tags/types popup from toolbar is squished
  o (#5787) Windows: Checkboxes in notes cannot be checked
  o (#5788) Windows: CKJ characters copied from notes get corrupted
  o (#5791) Selecting a font does not always work (wrong font in tag)
  o (#5798) Windows 7: Error messages on startup and during interaction due to missing emoji typeface
Version 11.0.18  
September 23, 2019  
•  Fixes  
  o  (#5767) Notes toolbar's "More Notes Editor Actions" button causes error  
  o  (#5782) If focus is set to notes by clicking below the note in the grey area, the hidden tags are not shown  
  o  (#5783) Bullets and other lists should not be indented when inside of a table  
  o  (#5784) Notes toolbar does not wrap icons properly  
  o  (#5785) Dragging above the top of the document should move the cursor to the start of the document

Version 11.0.17  
September 20, 2019  
•  Fixes  
  o  (#5773) Non-breaking spaces are flagged as spelling mistakes  
  o  (#5781) Setting justification on a note without a theme causes an error

Version 11.0.15  
September 19, 2019  
•  Fixes  
  o  (#5728) Drag to select of multiple right-justified lines can cause error  
  o  (#5750) Thought title within Brain tab doesn't update when thought name changed  
  o  (#5763) Issues with new icons conflicting with old icons  
  o  (#5764) Icon directory can no longer be customized  
  o  (#5765) Stock icons window should have a default category when in the Browse option  
  o  (#5771) Applying formatting (bold/italic/etc) does not work - selection is lost  
  o  (#5773) Non-breaking spaces are flagged as spelling mistakes

Version 11.0.14  
September 18, 2019  
•  New Features  
  o  (#4469) New library of over 1,900 modern icons  
  o  (#5660) Command to hide/show all Thought Types in a brain at once  
  o  (#5760) Icon discovery interface including browsing, suggestions, recent icons, and search  
•  Fixes  
  o  (#1544) ThirdPartyNotices.txt should be included by installer in root folder of application  
  o  (#3332) Select Stock Icon can be slow to load  
  o  (#4208) macOS: Double click title bar does not follow action set in System Preferences > Dock  
  o  (#5392) Read-only access user should not be able to make any changes  
  o  (#5426) macOS: Rotated text in plex and timeline does not show correctly  
  o  (#5536) Markdown notes are not counted distinctly from internal files in Statistics dialog  
  o  (#5647) macOS: TB11 Desktop Wallpaper scaling issue  
  o  (#5719) New note content is not showing up in search results  
  o  (#5720) Unable to delete an attachment, while BrainBox "Add attachment" window is open  
  o  (#5726) Changing justification on a heading centered by the theme causes error  
  o  (#5728) Drag to select of multiple right-justified lines can cause error  
  o  (#5732) notes.md file should not show in list of attachments when clicking on thought icon  
  o  (#5737) Cannot set heading centered by theme to left justified  
  o  (#5740) macOS: Double click in plex maximizes window  
  o  (#5744) Search box starts off thin  
  o  (#5751) Windows: Can't scroll areas that should be scrollable (lists of thoughts, etc)

Version 11.0.13  
September 9, 2019  
•  New Features  
  o  (#5644) Notes: Set custom font family for selected text  
  o  (#5727) Set justification of table column by adding justification prefix to cell in header row
• Fixes
  o (#5576) Tables in notes can only be left justified
  o (#5577) Checkboxes, bullets and numbered lists in tables
  o (#5681) Notes: Show local fonts only if cannot download list of fonts
  o (#5711) Notes: printing should set foreground to black and background to white
  o (#5717) Deleting the content of a note should delete the notes.md file
  o (#5718) Notes: Export to PDF when page color is not white leaves white at top and bottom of page
  o (#5721) Windows: Extra unused space in TPD
  o (#5722) Print button in Notes Toolbar is not working
  o (#5723) Note Font previews all look the same
  o (#5724) Frequent crashes after customizing my Note Fonts
  o (#5725) Clicking below a short note in the grey area should set focus to notes
  o (#5729) Column widths are not wide enough when a table cell includes a bullet/checkbox/numbered list
  o (#5731) Bullets and checkboxes do not render if the first word after the bullet is too long to fit on the line

Version 11.0.12
September 5, 2019
• New Features
  o (#3868) HTML file attachment should preview in built in browser
  o (#5685) Save notes before crashing
  o (#5691) Consolidate all notes preferences into a single preferences tab
• Fixes
  o (#5568) Drag and drop of an image from Google images into notes causes crash
  o (#5581) Insert hyper link in notes should add URL Name/Title
  o (#5582) Windows: Find and Replace in Notes - find/replace text boxes do not render
  o (#5632) Notes are not saved until a new thought is activated
  o (#5637) Can't scroll large Brains Thumbnail List
  o (#5695) Unable to copy Thoughts using selection window
  o (#5696) Paste url in Notes causes crash
  o (#5705) Line spacing should not be applied to non-editor keza controls
  o (#5706) Preferences can only be opened once
  o (#5707) Windows: Presentation mode causes TheBrain to crash
  o (#5716) macOS: Mouse drag operations don't work (resize splitter, drag and drop of tabs, etc)

Version 11.0.11
August 29, 2019
• New Features
  o (#5688) Plex thought sorting: (The) Beatles should sort with B bands, not T bands
• Fixes
  o (#5309) Upgrade notification sometimes ignores "Do not remind me" checkbox
  o (#5369) Reports time option set to bad date

Version 11.0.10
August 29, 2019
• New Features
  o (#3414) Saved Brain Theme should also save a Custom Notes Style
  o (#4264) Copy text style/format into notes
  o (#4713) Search web command auto-fills with selected text in notes
  o (#5643) Support for SVGs in notes
  o (#5664) Preferences for new editor
  o (#5689) Editable Notes Styles
• Fixes
  o (#1436) When docking a floating tab, the resulting tab has the compact style toolbar
  o (#2704) Notes Editor - Custom font color is not saved
  o (#4497) Windows: Note menu selections do not work if you are clicking over an open Report
  o (#4521) Note icon is not always removed after the note content is deleted
• Notes Editor: Paste text after a Shift+Enter (single space return) does not work
• Improve user experience of notes editor initialization
• Tags with hidden ordering number do not have checkmark in selection dialog
• Toggling Forgotten Thoughts on/off makes a Type that was not marked "Visible When Parent of Active" re-appear
• Adding an attachment from BrainBox using the "Add Attachment" window, causes other attachments' menu options to be grayed out
• Images that are in a heading are not displayed correctly
• Color selection popups do not have a background
• Timestamp in YouTube URLs is ignored in the embedded player
• Right click on attachment tab acts as if it is a right click on tab background area
• Opening the thought type/tag popup more than once causes an error
• Change wording in Import window - It is possible to undo an import
• Text entry content is not vertically aligned
• Windows: Notes toolbar does not adjust when content area is made narrower
• Update content on hover results in a crash

Version 11.0.6
August 2, 2019
• Fixes
  • Notes: Print not working
  • Windows: Notes pane will not go narrower than the tool bar
  • Missing fonts caused bold/italic and styles not to render correctly in notes
  • Windows: Multiple displays with different scales cause title bar to be shown at the wrong scale

Version 11.0.5
August 2, 2019
• New Features
  • Keyboard shortcuts for zoom in/out, etc of PDF being previewed
  • Printing of PDFs
  • Redesigned PDF Toolbar
  • Accurate, high performance, PDF rendering
• Fixes
  • Buttons not available in PDF viewer depending on window size
  • macOS: Keyboard navigation conflicts with multi page PDF attachment
  • PDF preview does not work when filename includes accented characters
  • Cursor jumping in notes editor
  • Spell check reverts super/subscript text
  • Strange issue with PDF preview
  • macOS: PDFs with unusual characters in their name do not display correctly
  • Dragging Attachments issues
  • Dragging URL to an existing Thought in Plex should not clobber thought name
  • macOS: Closing a modal dialog causes a hard crash
  • Windows: When only one tab and one window are open, clicking the tab causes the window to move
  • Windows: Close tab button does not work
  • Export to PDF does not work - results in crash
  • Set text foreground/background color in notes not working
  • Find and Replace - selection is not easily apparent
  • Windows: Cannot click on buttons in toolbar (account/avatar, inbox)
  • Windows: Floating a tab results in an error
  • Previewing large PDF file attachments causes TheBrain to hang
  • Tall images prevent pdf export and printing of that page
  • Extra large PDFs fail to render
  • Windows: Previewing a linked PDF attachment whose path does not exist anymore, causes hard crash
  • macOS: Text and other content does not show inside of embedded browser
Version 11.0.3
June 26, 2019

• New Features
  o (#346) Spellcheck for Thought names
  o (#2058) Notes: Center/Right/Left paragraph alignment
  o (#2201) Typing "[ ]" or "." or "+" at the start of a line creates a checkbox
  o (#2167) Markdown support in notes
  o (#2647) Do not hide notes toolbar when not in use
  o (#3109) Support for tables in notes
  o (#3782) Typing "*" at the start of a line creates a bullet list item
  o (#4207) Improved find and replace UI, not covering notes content
  o (#4372) Leave cursor on highlighted text after using Find/Replace
  o (#4467) Notes: Inline code formatting
  o (#5276) macOS: Option to make dark/light theme follow OS automatically
  o (#5424) Brain Statistics: Show number of thoughts with assigned icons and total icon files size
  o (#5434) macOS: Faster embeded browser
  o (#5474) macOS: Improved keyboard access to dialog boxes via `Tab` key
  o (#5558) macOS: Faster rendering and smoother animation

• Fixes
  o (#592) Notes background color does not change sometimes
  o (#1045) Numbered lists in Notes do not match font size of surrounding text.
  o (#1443) Inserting a Checkbox in notes pushes an existing line down
  o (#1571) Popup menus appear at cursor location instead of button location
  o (#1638) Typing at the end of a pasted URL in Notes Editor is not intuitive
  o (#1681) Mac: URL Link Icon Not Deleted when using `⌘+A` to select all and delete
  o (#1732) Mousedown in notes view sets focus
  o (#1739) Notes find and replace native dialogs
  o (#2106) Large notes can cause issues
  o (#2114) Notes Editor: Issues with nested numbered lists and checkbox lists
  o (#2287) Selecting multiple rows of an UL OL or checkbox and pressing tab/shift tab should indent/outdent
  o (#2329) Refactor SpellChecker C#JS API to check many words at once
  o (#2499) Notes Editor - SuperScript appears wrong and cannot be removed
  o (#2515) Notes Editor - Tables in Notes lose formatting when Spellcheck is on
  o (#2726) Notes: Selecting a color does not work if no text is selected
  o (#2806) macOS: Placeholder text for Thought Name is difficult to see on dark background Brains
  o (#3161) Windows: NotesEditorWebView only initializes when the notes editor is visible
  o (#3294) Notes: Cursor placement can affect functionality of buttons
  o (#3333) Notes Editor typing delay
  o (#3334) macOS: toggling Show Word Count removes cursor from notes window
  o (#3340) Notes: Return is not inserted when a selection exists
  o (#3554) YouTube links in Notes do not open properly in browser
  o (#3746) Notes editor spelling error appearance
  o (#3769) "Toggle Checkbox List" button in Notes not rendered properly.
  o (#3811) macOS: When emoji icons are used for a Thought icon, sometimes they are drawn as two characters
  o (#3860) Notes Editor: Spell check causes each run of multiple spaces to be converted to one space
  o (#3869) Not possible to write under a horizontal ruler in Notes with list above.
  o (#3885) YouTube videos in Notes are Low Res
  o (#3886) Windows: Pasting a Vimeo URL into notes - video doesn't play
  o (#3917) Notes: Cursor goes to invalid spot
  o (#3918) Notes Editor: Paste URL into URL causes problems (paste URL twice)
  o (#3921) Notes Editor: spell-check should not replace all instances of same misspelled word when user replaces one
  o (#3946) Spaces or tabs at the start of a line in notes are lost
  o (#4136) Text copied and pasted from notes into Gmail does not allow line breaks between words
  o (#4144) Notes: Spell checking does not work when there are hyphens in words
- (#4195) Cursor jump when selection spans multiple lines
- (#4229) Notes - Right click directly to the right of a word auto selects the word
- (#4292) Notes Editor: Pasting a Local Thought URL onto selected text should use correct icon
- (#4302) Small Grey box appears/blink in Notes area
- (#4503) Chinese input is adding characters in notes, rather than replacing
- (#4684) macOS: Notes: Dragging the icon to the right of a URL causes a crash
- (#4915) Until notes is displayed, sometimes "Waiting for editor to be ready" repeats in the log
- (#4957) Indented checkboxes do not work
- (#4971) Windows: Emojis should be ignored by spellchecker in the notes editor
- (#5069) Find and Replace dialog not keeping keyboard focus
- (#5144) URLs added to BrainBox get named properly but their name is lost on dragging to plex
- (#5194) Notes Code style removes indents
- (#5386) Letters with Spanish accents being incorrectly entered
- (#5394) Input lag on notes
- (#5395) Ctrl+B to bold text in Notes is not functioning properly
- (#5402) Notes periodically unresponsive
- (#5487) Find & Replace window in Notes is not dismissed when navigating to another Thought